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Surface Analysis and 3D VisualizationSurface Analysis and 3D Visualization

Surface Model Data SetSurface Model Data Set
Grid vs. TINGrid vs. TIN
2D vs. 3D shape2D vs. 3D shape

Creating Surface ModelCreating Surface Model
Creating TINCreating TIN
Creating 3D featuresCreating 3D features

Surface Model VisualizationSurface Model Visualization
2D shaded relief mapping2D shaded relief mapping
3D perspective viewing3D perspective viewing
Image Draping Image Draping 

Surface Model AnalysisSurface Model Analysis
Interactive Contouring and Contour MappingInteractive Contouring and Contour Mapping
Profiling and Surface RunoffProfiling and Surface Runoff
Measuring surface area and volumes, cut and fillMeasuring surface area and volumes, cut and fill
Line of sight and visibility analysisLine of sight and visibility analysis
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Surface Model Data StructureSurface Model Data Structure
GridGrid

Regulated square Regulated square 
cells cells 

2D shapes2D shapes
X, YX, Y

TINTIN
Triangulated Irregular Triangulated Irregular 
Network Network 

3D shapes3D shapes
X, Y, Z (Elevation)X, Y, Z (Elevation)
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Grid Surface Data ModelGrid Surface Data Model

Grid Surface ModelGrid Surface Model
Raster data model using a mesh of regularly spaced points Raster data model using a mesh of regularly spaced points 

Simple and easy to process, take a lot of storage spaceSimple and easy to process, take a lot of storage space

FixedFixed--resolution determined by the cell size as a result of interpolatresolution determined by the cell size as a result of interpolationion

Rigid mesh structure does not adapt to the variability of terraiRigid mesh structure does not adapt to the variability of terrainn

Source data may not be captured, which may cause lose of informaSource data may not be captured, which may cause lose of information  tion  

Prevent linear features from being represented sufficiently Prevent linear features from being represented sufficiently 
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TIN Surface Data ModelTIN Surface Data Model

TINTIN
Vector data model using continuous, Vector data model using continuous, nonoverlappingnonoverlapping triangle facets.triangle facets.
Elevation values (z) along with x, y coordinates are stored as nElevation values (z) along with x, y coordinates are stored as node of ode of 
the trianglesthe triangles
Take less storage space but difficult to processTake less storage space but difficult to process
VariableVariable--resolution adapt to the variability of terrain and perform resolution adapt to the variability of terrain and perform 
interpolation on the flyinterpolation on the fly
More detailed when surface is complex, less detailed when simpleMore detailed when surface is complex, less detailed when simple
Source data maintained as part of triangulation, no information Source data maintained as part of triangulation, no information loselose
Can represent linear features by enforcing them as triangle edgeCan represent linear features by enforcing them as triangle edges s 
((breaklinebreakline))
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Creating Surface Model DataCreating Surface Model Data

Create Grid Surface ModelCreate Grid Surface Model

Create TIN Surface ModelCreate TIN Surface Model

Conversion between TIN and GridConversion between TIN and Grid

Create 3D Shapes InteractivelyCreate 3D Shapes Interactively

Convert Existing 2D Data into 3D DataConvert Existing 2D Data into 3D Data
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Creating Grid (preview)Creating Grid (preview)

InterpolationInterpolation
IDWIDW

Weights the points closer to the processing cell more heavily thWeights the points closer to the processing cell more heavily than an 
those father awaythose father away

SplineSpline
Fits a minimum curvature surface through the input pointsFits a minimum curvature surface through the input points

KrigingKriging
Fits a mathematical function to a specified number of points, orFits a mathematical function to a specified number of points, or all all 
points within a specified radius to determine the output valuespoints within a specified radius to determine the output values

Natural NeighborsNatural Neighbors
Creates a Creates a DelauneyDelauney Triangulation of the input points and selects Triangulation of the input points and selects 
the closest nodes that form a convex hull around the interpolatithe closest nodes that form a convex hull around the interpolation on 
point, then weights their values by proportionate area. point, then weights their values by proportionate area. 
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Creating and Editing a TINCreating and Editing a TIN
Specifying height sourceSpecifying height source

3D shape: shape3D shape: shape

Others: 2D + Attribute field or noneOthers: 2D + Attribute field or none

Specifying the surface feature typeSpecifying the surface feature type
Mass points, Mass points, breaklinesbreaklines, polygons, polygons

Specifying node and triangle tag value field (Optional)Specifying node and triangle tag value field (Optional)
Point: Integer value attribute for the nodePoint: Integer value attribute for the node

Polygon: Integer value attribute for the triangle facetPolygon: Integer value attribute for the triangle facet

Editing existing TINEditing existing TIN
Modifying a surface model without having to reModifying a surface model without having to re--create it from scratchcreate it from scratch

Active feature themes and an editable TIN themeActive feature themes and an editable TIN theme
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Specifying a Feature TypeSpecifying a Feature Type

Surface Feature TypesSurface Feature Types
Mass pointMass point: Individual triangular node, e.g. GPS, LIDAR points: Individual triangular node, e.g. GPS, LIDAR points
BreaklineBreakline: Enforced as triangular edges, no triangular is allowed to : Enforced as triangular edges, no triangular is allowed to 
cross a cross a breaklinebreakline

HardHard: Distinct changes in slope, e.g. stream, road, or lakeshore : Distinct changes in slope, e.g. stream, road, or lakeshore 
SoftSoft: Mark boundaries that are not physical features of the landscap: Mark boundaries that are not physical features of the landscape, e.g. e, e.g. 
edge of Tin, political boundary, vegetation or soil types, so thedge of Tin, political boundary, vegetation or soil types, so that each triangle at each triangle 
will be assigned to one feature typewill be assigned to one feature type

Contour: Every vertex will served as mass point and become nodeContour: Every vertex will served as mass point and become node
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Specifying a Feature Type (count.)Specifying a Feature Type (count.)

Surface Feature TypesSurface Feature Types
Polygon features: Triangular edge and node (vertex)Polygon features: Triangular edge and node (vertex)

Replace polygonReplace polygon: Replace interpolated values with a constant value.: Replace interpolated values with a constant value.

Erase polygonErase polygon: Area within the polygon are marked as being outside the zone o: Area within the polygon are marked as being outside the zone of f 
interpolation.interpolation.

Clip polygonClip polygon: Area outside the polygon are marked as being outside the zone : Area outside the polygon are marked as being outside the zone of of 
interpolation.interpolation.

Fill polygon:Fill polygon: Assign numeric attribute values to triangles. No height replaceAssign numeric attribute values to triangles. No height replacement, ment, 
erasing, or clipping takes place.erasing, or clipping takes place.
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Conversion between TIN and GridConversion between TIN and Grid

Convert (TIN) to GridConvert (TIN) to Grid
Specify horizontal accuracy (cell size)Specify horizontal accuracy (cell size)

All the nodes of the triangles will be interpolated.All the nodes of the triangles will be interpolated.

Converting Grid to TINConverting Grid to TIN
Specify vertical accuracy (ZSpecify vertical accuracy (Z--value tolerance)value tolerance)

3D Analyst will automatically select the subset of the grid cell3D Analyst will automatically select the subset of the grid cell centers centers 
and use them as nodes to create TIN so that the difference betweand use them as nodes to create TIN so that the difference between en 
the original elevation and estimated elevation from TIN is withithe original elevation and estimated elevation from TIN is within the n the 
maximum Zmaximum Z--value tolerancevalue tolerance
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Construction of trianglesConstruction of triangles

DelaunayDelaunay triangulationtriangulation
All nodes (points) are connected to the nearest neighbors to All nodes (points) are connected to the nearest neighbors to 
form triangles;form triangles;

Triangles are as equiangular, or compact, as possible. Triangles are as equiangular, or compact, as possible. 
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Create a 3D FeatureCreate a 3D Feature
Creating an empty 3D Creating an empty 3D shapefileshapefile

ArcCatalogArcCatalog NewNew ShapefileShapefile
Check Check ““Coordinates will Coordinates will 
contain Z valuecontain Z value””. Used to store . Used to store 
3D data3D data

Converting 2D to 3DConverting 2D to 3D
3D Analyst>Covert> Features to 3D Analyst>Covert> Features to 
3D3D

Specify Source of heightSpecify Source of height

Height Surface: TIN or GridHeight Surface: TIN or Grid

Input Feature Attribute: Input Feature Attribute: 
numerical fieldnumerical field

Numerical Constant: e.g. 100Numerical Constant: e.g. 100

Creating 3D interactivelyCreating 3D interactively
Add an empty 3D Add an empty 3D shapefileshapefile

Activate a surface modelActivate a surface model
TIN or GridTIN or Grid

Editor>Start Editing Editor>Start Editing 

Selecting Digitizing Interpolate Selecting Digitizing Interpolate 
Interpolate LineInterpolate Line

Interpolate PointInterpolate Point

Interpolate PolygonInterpolate Polygon

Stop Editing and Save EditsStop Editing and Save Edits
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2D Surface Display and 3D Visualization2D Surface Display and 3D Visualization

ArcMapArcMap
Generate 2D Hill ShadeGenerate 2D Hill Shade

Assign Brightness DepthAssign Brightness Depth

Symbolizing TINSymbolizing TIN

ArcSceneArcScene and and ArcGlobeArcGlobe
3D Perspective Visualization and Navigation3D Perspective Visualization and Navigation

Image DrapeImage Drape

AnimationAnimation

Create realCreate real--world models with 3D symbolsworld models with 3D symbols
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2D 2D HillShadingHillShading
Hill ShadeHill Shade

Compute surface illumination as Compute surface illumination as 
values from 0 to 255 based on an values from 0 to 255 based on an 
imaginary light sourceimaginary light source

Cast shade or shadows to create a Cast shade or shadows to create a 
shaded relief effectshaded relief effect

AzimuthAzimuth: angular direction of the : angular direction of the 
sun, measured from north in sun, measured from north in 
clockwise degrees from 0 to 360clockwise degrees from 0 to 360

AltitudeAltitude: angular elevation of the sun : angular elevation of the sun 
above the horizon with degrees from above the horizon with degrees from 
0 (on the horizon) to 90 (overhead)0 (on the horizon) to 90 (overhead)

Altitude

Azimuth

)sin()cos(
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PurposePurpose
Use one grid theme to vary the brightness of cell Use one grid theme to vary the brightness of cell 
color in another grid themecolor in another grid theme

Represent how variable is spatially distributed and Represent how variable is spatially distributed and 
how another variable change with ithow another variable change with it

Reveal the relationship between two grid themes Reveal the relationship between two grid themes 

Shading a raster with a Shading a raster with a hillshadehillshade
Create a Create a hillshadehillshade

3D Analyst> Surface Analysis > 3D Analyst> Surface Analysis > HillshadeHillshade

Make the Make the hillshadehillshade layer semilayer semi--transparenttransparent
Properties > Display > Transparent 50%Properties > Display > Transparent 50%

Display the Display the hillshadehillshade layer on top of other layerslayer on top of other layers

Shade a surface in a sceneShade a surface in a scene
Properties > Rendering> Effects> Shade areal Properties > Rendering> Effects> Shade areal 
feature relative to the scenefeature relative to the scene’’s lights light

Shade a raster/surface with a Shade a raster/surface with a hillshadehillshade
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Symbolizing of TINSymbolizing of TIN

Symbolizing TINSymbolizing TIN
Single featuresSingle features

PointsPoints
Mass point

LinesLines
Triangle Edges
Hard or soft 
breaklines

FacesFaces
Elevation
Aspect, slope, tag 
value

Combination of the Combination of the 
features  features  
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Displaying TIN Nodes by ElevationDisplaying TIN Nodes by Elevation

TIN> Properties > TIN> Properties > SymbologySymbology > Add> Add
NodeNode

Single symbol: Nodes with same symbolSingle symbol: Nodes with same symbol
Graduated Color: Node elevation graduated Graduated Color: Node elevation graduated colorrampcolorramp
Unique color: Node tag value grouped with unique symbolUnique color: Node tag value grouped with unique symbol
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Display TIN Edge Lines Display TIN Edge Lines 

TIN> Properties > TIN> Properties > SymbologySymbology > Add> Add

EdgesEdges
Edge with same symbolEdge with same symbol

Edge type with grouped symbolEdge type with grouped symbol
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Display TIN FacesDisplay TIN Faces

TIN> Properties > TIN> Properties > SymbologySymbology > Add> Add

FaceFace
Faces with the same symbolFaces with the same symbol

Faces elevation with graduated color rampFaces elevation with graduated color ramp

Face aspect/slope with graduated color rampFace aspect/slope with graduated color ramp
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3D Scene Visualization3D Scene Visualization
3D Scene or 3D Scene or ArcGlobeArcGlobe

A new program introduced in the ArcGIS 8 and 9A new program introduced in the ArcGIS 8 and 9
ArcGIS>ArcGIS>ArcSceneArcScene or ArcGIS or ArcGIS ArcGlobeArcGlobe
3D Analyst included3D Analyst included
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3D Properties of a Theme3D Properties of a Theme
Base HeightBase Height

Elevation values for Elevation values for 
every measurable every measurable 
locationlocation

Z Unit ConversionZ Unit Conversion
Multiply by ZMultiply by Z--factorfactor

Offset HeightOffset Height
An offset applied to An offset applied to 
the base heightthe base height
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3D Properties of a Theme3D Properties of a Theme
ExtrusionExtrusion

Extended a feature to a certain height from base heightExtended a feature to a certain height from base height

Change the form of featuresChange the form of features
Point Point vertical linevertical line

Line Line vertical wallvertical wall

Polygons Polygons 3D block3D block
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Image DrapingImage Draping

Assign the base height of a surface to the imageAssign the base height of a surface to the image
Assign the base height of the buildings to surface Assign the base height of the buildings to surface 
and extrude the buildings to certain height.and extrude the buildings to certain height.
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MultiMulti--layered Displaylayered Display

Add different offsets to layers to form a multiAdd different offsets to layers to form a multi--layered layered 
displaydisplay
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3D Statistic Mapping 3D Statistic Mapping 

Use population of each county to extrude featureUse population of each county to extrude feature

Texas Population 3D Statistic Map
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Extrusion MethodsExtrusion Methods
Options: Options: 

Adding to base height: the extrusion expression is added to eachAdding to base height: the extrusion expression is added to each
theme feature.theme feature.

Use it as a value the features will extended to: Extrusion expreUse it as a value the features will extended to: Extrusion expressions ssions 
can result in values that are positive or negative relative to tcan result in values that are positive or negative relative to their base heir base 
height. height. 

Extrusion is only an option for feature themes.Extrusion is only an option for feature themes.
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IlluminationIllumination

Shade themeShade theme
Illuminate a theme to add a sense of depth and realismIlluminate a theme to add a sense of depth and realism
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TransparencyTransparency

TransparencyTransparency
Control how transparent a themeControl how transparent a theme’’s feature will be, from completely s feature will be, from completely 
opaque to completely transparent.opaque to completely transparent.
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Navigating, Zoom, Rotating and Flying Navigating, Zoom, Rotating and Flying 
in a 3D Scenein a 3D Scene

Navigate Navigate 
RotateRotate

Left button: Left button: 
horizontal/verticalhorizontal/vertical

Zoom In/OutZoom In/Out
Right button: up/down Right button: up/down 

PanPan
Left+right buttonLeft+right button

Fly forward/backwardFly forward/backward
Ctrl+up/down arrowCtrl+up/down arrow

Zoom In/OutZoom In/Out

Center on targetCenter on target

Zoom to targetZoom to target

Set observerSet observer



9-31Spatial Analysis: Dr. Fang Qiu

Exporting Scene to 2D and 3DExporting Scene to 2D and 3D

Exporting to 2D ImageExporting to 2D Image
JPEG, TIFF, PCX, JPEG, TIFF, PCX, ……..

Exporting to 3D FilesExporting to 3D Files
VRMLVRML
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Properties of a 3D SceneProperties of a 3D Scene
Vertical ExaggerationVertical Exaggeration

Increasing or decreasing the Increasing or decreasing the 
vertical extent of the surface vertical extent of the surface 
modelmodel

Background ColorBackground Color
Default is blackDefault is black

Sun PositionSun Position
Sun AzimuthSun Azimuth

Sun AltitudeSun Altitude

ContrastContrast
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Vertical ExaggerationVertical Exaggeration

Without vertical exaggerationWithout vertical exaggeration With vertical exaggeration of 5With vertical exaggeration of 5
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Sun PositionSun Position

Altitude: Very LowAltitude: Very Low Altitude: HighAltitude: High

Azimuth: NortheastAzimuth: Northeast Azimuth: SouthwestAzimuth: Southwest
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3D 3D SymbologySymbology, graphics and text, graphics and text
3D 3D SymbologySymbology

3D Point styles3D Point styles
3D Line styles3D Line styles
3D Polygon styles3D Polygon styles

Textures, such as grassTextures, such as grass

GraphicsGraphics
PointPoint
LineLine
PolygonPolygon

TextText
3D Text3D Text
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AnimationAnimation
What is animationWhat is animation

A collection of tracks or key frames that defines dynamic A collection of tracks or key frames that defines dynamic 
property changes related to associated objectsproperty changes related to associated objects.

Tracks:Tracks:
Tracks control dynamic changes of the properties of an object, sTracks control dynamic changes of the properties of an object, such uch 
as a documentas a document’’s background color, a layers background color, a layer’’s visibility, or a cameras visibility, or a camera’’s s 
locationlocation.

Tracks are made up of a set of Tracks are made up of a set of keyframeskeyframes..

KeyframesKeyframes::
A A keyframekeyframe is a snapshot of a particular objectis a snapshot of a particular object’’s properties at a s properties at a 
certain time.certain time.

Export it as movie fileExport it as movie file
Video file in .Video file in .aviavi or .or .movmov filefile
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Creating AnimationCreating Animation
Capture Capture KeyframesKeyframes

Use the Capture View command to save Use the Capture View command to save 
perspective views as perspective views as keyframeskeyframes in a camera in a camera 
track.track.
The resulting track will be an interpolation The resulting track will be an interpolation 
between the between the keyframeskeyframes, making a smooth , making a smooth 
animation.animation.

Recording navigationRecording navigation
Simple recording and playback are achieved Simple recording and playback are achieved 
using controls that resemble a VCR.using controls that resemble a VCR.

Making a camera flyby from a pathMaking a camera flyby from a path
Use a selection tool and select the line feature Use a selection tool and select the line feature 
or graphic then use it as a path for Camera or graphic then use it as a path for Camera 
Flyby pathFlyby path
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ArcGlobeArcGlobe
Two ModesTwo Modes

Globe mode: Globe mode: 
With a perspective always perpendicular With a perspective always perpendicular 
to earthto earth’’s surface and camera target to s surface and camera target to 
the center of the globethe center of the globe

Surface mode: Surface mode: 
Same of Same of ArcScenceArcScence and allow to work and allow to work 
with your data at a lower elevation, with your data at a lower elevation, 
allows additional perspective viewing allows additional perspective viewing 
characteristics, and sets the camera characteristics, and sets the camera 
target on the surface of the globe.target on the surface of the globe.

Switch between the two modesSwitch between the two modes
Click Navigation Mode buttonClick Navigation Mode button

Centering on a target sets a target on Centering on a target sets a target on 
the globe surface and switches to the globe surface and switches to 
Surface mode.Surface mode.
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ArcGlobeArcGlobe BasicsBasics
ArcGlobeArcGlobe Layer TypesLayer Types

Elevation layerElevation layer
Elevation layers provide height information Elevation layers provide height information 
to the globe surface. These are to the globe surface. These are rastersrasters with with 
height source information to provide height source information to provide 
topography to the globe surface, making it a topography to the globe surface, making it a 
globe terrain.globe terrain.

Drape layerDrape layer
Draped are placed on the globe surface and Draped are placed on the globe surface and 
use any elevation data present to show base use any elevation data present to show base 
heights.heights.

Floating layerFloating layer
Floating layers are layers that float Floating layers are layers that float 

independently of the globe surface. Raster independently of the globe surface. Raster 
as a floating layer are set to elevations not as a floating layer are set to elevations not 
connected with the globe surface.connected with the globe surface.

Animation Tools and CommandsAnimation Tools and Commands
Animate viewer using tools and Animate viewer using tools and 
commandscommands
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Surface Model AnalysisSurface Model Analysis

Surface Model AnalysisSurface Model Analysis
Identifying and Selecting 3D FeatureIdentifying and Selecting 3D Feature

Interactive contour and contour mappingInteractive contour and contour mapping

Profiling and surface runoffProfiling and surface runoff

Measuring surface area and volumes, Measuring surface area and volumes, 

Cut and fillCut and fill

Line of sight analysis Line of sight analysis 

Visibility analysis with view shadeVisibility analysis with view shade
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Identifying and Selecting 3D featuresIdentifying and Selecting 3D features

Identifying featuresIdentifying features
Get information about a feature, such as slope, Get information about a feature, such as slope, 
aspect, height of a TIN facet.aspect, height of a TIN facet.

Selecting featuresSelecting features
Click to select features of interesting and draw in Click to select features of interesting and draw in 
the color of highlighting selectionsthe color of highlighting selections

Shift+Click = multiple selection of featuresShift+Click = multiple selection of features
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Contour and Contour MapContour and Contour Map

ContourContour
A line representing all A line representing all 
contiguous locations with the contiguous locations with the 
same height, magnitude, or same height, magnitude, or 
concentration of value of a concentration of value of a 
surfacesurface

Interactive ContouringInteractive Contouring

Contouring mapContouring map
Base contourBase contour

Contour intervalContour interval
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Surface Runoff Pattern and Profiling in Surface Runoff Pattern and Profiling in ArcMapArcMap
Steepest pathSteepest path

Interactively calculate the steepest Interactively calculate the steepest 
downhill path until the perimeter of downhill path until the perimeter of 
the surface is met the surface is met 

It is the path a ball would take if It is the path a ball would take if 
release form a given point release form a given point 

ProfileProfile
A side view of a 3D line draw on a A side view of a 3D line draw on a 
surface.surface.

The graph plots elevation on one The graph plots elevation on one 
axis, and distance on the otheraxis, and distance on the other

Profile graphs are created in Profile graphs are created in 
Layout documentLayout document
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Measuring Surface Area and VolumeMeasuring Surface Area and Volume

2D Area2D Area
The area on a horizontal plane of certain height that is interseThe area on a horizontal plane of certain height that is intersect with the ct with the 
surfacesurface

Surface AreaSurface Area
Area measured along the slope of a surface, taking height into cArea measured along the slope of a surface, taking height into considerationonsideration
Always greater than 2D Always greater than 2D planimetricplanimetric area, the rougher the surface, the larger area, the rougher the surface, the larger 
the surface areathe surface area

VolumeVolume
The cubic space between a surface and a horizontal plane of a spThe cubic space between a surface and a horizontal plane of a specific ecific 
elevationelevation
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Determining Cut and Fill?Determining Cut and Fill?
CutCut--FillFill

Determine how much material is lost or gained in an area Determine how much material is lost or gained in an area 
by comparing two surface models of itby comparing two surface models of it
One before a change and one afterOne before a change and one after
ResultsResults

Net Gain: > 0Net Gain: > 0
Unchanged: = 0Unchanged: = 0
Net Loss: < 0Net Loss: < 0

ApplicationApplication
Construction project: Calculate materials needs to be Construction project: Calculate materials needs to be 
movedmoved
Environmental application: Estimate changes in ground Environmental application: Estimate changes in ground 
waterwater
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Visibility AnalysisVisibility Analysis

Line of Sight in Line of Sight in ArcMapArcMap
Determine whether a given target is Determine whether a given target is 
visible form a point of observationvisible form a point of observation

If the target is obscured, the If the target is obscured, the 
coordinates of the first obstruction is coordinates of the first obstruction is 
given. given. 

Green: VisibleGreen: Visible

Blue: ObstructionBlue: Obstruction

Red: InvisibleRed: Invisible
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Visibility AnalysisVisibility Analysis
View ShadeView Shade

The area on a surface visible The area on a surface visible 
from one observation pointfrom one observation point

For any visible position, it For any visible position, it 
can be determined how can be determined how 
many observers can see that many observers can see that 
positionposition

Cumulative View ShedCumulative View Shed
The area on a surface can be The area on a surface can be 
visible from more than visible from more than 
observationobservation

The cell value for the view The cell value for the view 
shed record the number of shed record the number of 
observation points it can be observation points it can be 
visible. visible. 
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Customize Customize ViewshedViewshed AnalysisAnalysis

Customization by the fields of the observatory Customization by the fields of the observatory 
attribute tableattribute table

SPOT: the height of the observatory spotSPOT: the height of the observatory spot

OFFSETA: an offset added to the spot heightOFFSETA: an offset added to the spot height

OFFSETB: offset height added to target surface cellsOFFSETB: offset height added to target surface cells

AZIMUTH1: angles of first horizontal limit to the view fieldAZIMUTH1: angles of first horizontal limit to the view field

AZIMUTH2: angle of second horizontal limit to the view fieldAZIMUTH2: angle of second horizontal limit to the view field

VERT1: angle of VERT1: angle of UPPERUPPER vertical limit to the vertical limit to the viewfieldviewfield

VERT2: angle of VERT2: angle of LOWERLOWER vertical limit to the vertical limit to the viewfieldviewfield
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Application of 3D AnalysisApplication of 3D Analysis
TV Signal Accessibility and Airport PlanningTV Signal Accessibility and Airport Planning
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Lab 10. Fundamental and Advanced 3D analysisLab 10. Fundamental and Advanced 3D analysis

Fundamental Analysis: 3D features and visualizationFundamental Analysis: 3D features and visualization

Advanced analysis: Advanced analysis: ViewshedViewshed analysisanalysis
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Reading AssignmentReading Assignment

RequiredRequired
Chang: Chapter 15.4Chang: Chapter 15.4--15.615.6

Using ArcGIS 3D AnalystUsing ArcGIS 3D Analyst

RecommendedRecommended
DeMersDeMers: Chapter 7: Chapter 7


